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Introduction 

The gINT system is a product from Bentley for centralized data management and 
reporting for geotechnical subsurface projects. The software has been customized for the 
Geotechnical Branch of the Kentucky Transportation Cabinet (KYTC), with involvement from 
Kentucky Geological Survey (KGS), to allow the entry of drill hole, sample, and lab testing data 
collected in the course of geotechnical projects. The system has been set up to permit project 
managers, drillers, geologists, and lab personnel to enter data that they are responsible for. Once 
data entry for a project is complete and has been verified, a variety of hard copy or electronic 
reports can be printed that summarize the entered data. This document is a guide to proper input 
of information for the KYTC Geotechnical Branch’s specific gINT system. 
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General Guidelines 

Initial Startup. When you first start the software, it displays a Web page from 
www.gintsoftware.com. To begin using the software, you will either open an existing project 
database from the File menu or create a new empty database using the KYTC template (new 
blank gINT files are only generated by the KYTC Geotechnical office). Alternatively, you can 
get started by clicking the INPUT tab and selecting an existing project, or clicking the OUTPUT 
tab for generating reports of previously entered data.  

Main Types of gINT Files. The two main gINT files that are need for proper input of 
information is the Project Database file (.gpj) and the current KYTC Library file (.glb). The 
Project Database file holds the project specific information in a relational database format. The 
Library file supplies a set of report forms, symbol sets, data entry lookup lists, user functions, 
and other objects specific for KYTC. A third file used for creation of blank Database files by 
KYTC is the Data Template file (.gdt). 

Project Naming Convention. The convention for project naming is a letters for what type of 
project, dash, number of type of project for that year, dash, year of project record created. The 
most common project types are C (Construction), L (Landslide), M (Miscellaneous), P 
(Planning), S (Structure), R (Roadway). If an “A” is added to the project type it denotes an 
addendum. For example, if a project name is R-030-2016 then the gINT files is the thirtieth 
roadway project created for 2016. 

User Permissions. Data entry groups and individual tables have been designed to provide edit 
access to staff according to their responsibilities.  These user groups are Administrators, Drillers, 
Geologists, Soil Lab, and Rock Lab personnel.  User identity is determined by your login name 
on the workstation.  Each tab in the program consults a system database to determine whether the 
user has permission to edit.  Only the system administrators can add or modify permissions for 
users. This is done by editing the library table GR009 PERSONNEL under the DATA 
DESIGN / LIBRARY DATA tab.  To add a new user, enter the user’s network login name and 
choose the Department from the pull down menu. 

Data Input. In the INPUT application, entry forms are grouped under tabs according to who is 
responsible for the data, and individual forms are presented in the order in which data should be 
added. The best practice is to move from left to right with entering data into gINT since creation 
of information in one tab can be dependent on information entered in previous tabs. Columns on 
entry forms may be colored to indicate specific entry rules or conditions.  Yellow columns are 
required fields – you can’t save the record until that data is provided.  Gray columns are 
calculated fields and do not allow data entry by users.  Blue columns typically store values 
calculated from other fields, but allow for manual entry if the raw data do not exist.  White 
columns are for manual data entry only.  All fields that allow data entry are either free text entry 
or a pull down menu.  When you click in a field, an arrow will appear on the right side of the 
column if a menu is available.  If you need to enter a value that is not on the list, you can enter it 
manually then hit the <Enter> key. 

http://www.gintsoftware.com/


5 
 

Help Messages. There are two levels of help built into the data entry forms.  General 
information about the Tab (or database table) can be found by clicking the Table Help button on 
the right side of the form’s bounding box.  Information specific to a particular field is displayed 
at the bottom of the screen when you click any item in that column. Both locations are shown in 
Figure 1.  

 

 
Figure 1. Help Message and Save Button Locations 

Saving Your Work. The save button is the third icon from the left on the tool bar (looks like a 
floppy disk – if you remember those). When any data value has changed for the active tab, this 
icon will appear dark signifying that data is not saved. You can save your work at any time by 
clicking the save icon. Also, if you select another entry Tab, all changes will automatically be 
saved for you.  Internal calculations are done as part of the save function (or in some cases, after 
save), so you may not see these values on the form until data is saved. There may be instances 
when saving generates a programming error or exception. If this happens, you may not be able to 
leave the Tab you are working in at the time. If this occurs, click the “Roll Back” tool located at 
the far right side of the toolbar which will return the data to the previous saved version. Both are 
shown in Figure 1. 

  

Help 

Help 

Save 
Roll Back 
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gINT Project Setup 

Creating a new project. (applicable to KYTC Geotechnical Branch only) The process of 
creating a new project involves extracting project data from the KYTC project management 
system, opening an empty project file in gINT using the KYTC template, then importing the data 
into gINT. 

Step 1.  Start the KYTC project management system 
(http://kgs.uky.edu/kgsweb/KYTC/project_index.asp), and log in as GT Administrator with 
password Admin312. 

• Select “Search/Edit Projects…” 
• Enter criteria that will list the project(s) that you wish to set up in gINT 
• On the search result page, click the “Export CSV File” link on the desired project line.  

Save all files to a common folder called ProjectImport (recommended, not required) 
• Repeat similar downloads for all desired projects 
• Note: the filenames will automatically be named “geotechproject_id”.csv (e.g. R-001-

2007.csv). Be careful not to save this file in a location where it may overwrite a similarly 
named file used for another purpose. 

 
Step 2.  Start gINT and create a new, empty gINT project, assigning the name of the Geotech 

project 
• File > New Project > Clone Data Template 
• Select “kytc#.gdt” as the template, then click OPEN (where # is the current library 

version) 
• Enter the project id as the file name prefix, then click SAVE 

 
Step 3.  When the new project loads, the Input > Main Group > Project tab will be active (if not, 

make it so). You will see five fields with default data – all others should be blank. 
• Select File > Import/Export > Import From Text File 
• For Text File, click the load button (three dots) and navigate to the folder where you 

saved the project csv file 
• Leave Correspondence blank 
• Set Overwrite Options to “Named Fields” 
• Click OK 
• You should get a dialog window with a message “1 record imported” – click OK 

 
Horizontal and Vertical Accuracy Fields 

The default Horizontal Accuracy is assigned the value <1 (hi-resolution GPS) and is assumed to 
be NAD83 datum. This can be changed to a lower accuracy if another method was uniformly 
used for determining hole coordinates. These values will be assigned to similar fields in the Drill 
Hole tab for each hole. Following are the common methods and their assumed accuracy in feet: 

 Hi-resolution GPS < 1 
 Tape   1-15 
 Hand-held GPS 15 – 30 
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 Topo map  > 30 

The default Vertical Accuracy is assigned the value <0.5 (hi-resolution GPS) and is assumed to 
be NAVD88 datum. If another method was used to determine hole elevations, select an accuracy 
value consistent with that method. Following are the common methods and their assumed 
accuracy in feet: 

 Hi-resolution GPS < 0.5 
 Transit   0.5 
 Handlevel  1-4 
 Topo map  > 4  

If a local benchmark was used for elevation, enter the benchmark coordinates in the BM Latitude 
and BM Longitude fields and set the Vertical Datum to “Assumed”. 

Importing Holes into a New Project. You can also import data from a coordinate data file into 
the Drill Hole tab so that the hole locations don’t have to be manually entered. 

Step 1.  Verify you have the correspondence (translation) file (coordinate.gci). 
 
Step 2. Import the hole locations from a coordinate file 

• Open the coordinate file in notepad, and insert the text, **Point, on the line above the 
header line 

• Make sure the header field names match the example below  
 
ID,Latitude,Longitude,Hole, Elevation(ft),Station,Offset 
  

• Save the text file 
• Activate the Main Group > Drill Hole tab 
• Select File > Import/Export > Import From Text File 
• For Text File, click the load button (three dots) and navigate to the folder where you 

saved the coordinate file 
• For Correspondence File select Coordinate.gci 
• Set Overwrite Options to “Empty Fields” 
• Click OK 
• You should get a dialog window with a message “# records imported” – click OK 

 
Station footages are converted to numeric format (without the +) in the gINT database. That’s 
done to allow sorting of holes by station number—they will be reformatted with the + at report 
time. Check the offset footages after import to make sure they translated properly from text 
format to numeric (positive right, negative left). 
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Important!  The initial Hole Depth value in the Drill Hole tab is incorrect because it is not 
included in the coordinate data file.  Because it is required by gINT, a temporary value (999) 
must be assigned during import.  Make sure that the actual hole depths are added prior to 
entering any driller or geologist hole data, otherwise the depth checks will generate error 
messages. Also, enter any additional header data for each hole before proceeding with the other 
tabs. 
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General Drilling Information 

Drill Hole Table 

The overall information for drilling is entered into the Drill Hole tab. This table contains 
information about the holes drilled. The specifies for each field in the Drill Hole tab is discussed 
below, going from right to left. 

Hole Number As Staked. (required field) This values is the number given to the hole from the 
coordinate data submission form or value assigned to any additional holes drilled. This value 
needs to be unique for each project. 

Hole Complete. Check this box when all subsurface data for the hole has been entered and 
verified. This will prevent any data modifications for that hole 

Station Footage (ft). Station, in feet, for specific hole without “+”. The “+” will be added at 
report time. 

Offset (ft). Offset from alignment for specific hole in feet with offset to the right having a 
positive value and offset to left having a negative value. 

Hole Moved. If the drilled hole location differs from that given in the coordinate data 
submission form (as imported), then check this box and enter the correct station/offset footage. If 
you have new coordinate values for this location you can enter them, otherwise, when you save 
you will be prompted to choose whether you want to delete the original coordinates (as a 
reminder to replace them) or keep them and reduce the accuracy of the hole location. If boring 
hole locations are moved more than 5 feet then it is standard practice that the location should be 
resurveyed. If for some reason resurveying is not completed, the accuracy of the hole should be 
reduced.  For example, if the hole was moved ten feet, but not re-surveyed, you should change 
the horizontal accuracy to “Tape”.  Note:  Leave this boxed check, even if the new coordinates 
are entered, to preserve that information. 

Total Hole Depth (ft). (required field) The total depth of the hole drilled in feet. If hole 
information was imported then the default value of “999” should be replaced with the actual 
value. 

Surface Elevations (ft). The surveyed elevation of the top of the drilled hole. If hole is moved 
then new elevation should be recorded with the appropriate level of accuracy recorded in the 
Vertical Accuracy field. 

Latitude83. The latitude value for the specific hole from surveying. 

Longitude83. The longitude value for the specific hole from surveying. 

SZ_Northing. This value is the Kentucky Single Zone Northing value in feet. This value is 
calculated from the Latitude83 and Longitude83 upon save of the table. 

SZ_Easting. This value is the Kentucky Single Zone Easting value in feet. This value is 
calculated from the Latitude83 and Longitude83 upon save of the table. 

Hole Angle. The value should be -90 for vertical holes, and 0 for horizontal holes. 
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Drilling Dates (Start Date and End Date). If the hole was completed on the same day it started, 
then you only need to enter the Start Date. If the End Date is blank, the program will assign the 
value of the start date. 

Hole Type. This field is used to document the type of boring hole. This field will trigger certain 
functions and calculation in other tabs. Select core hole when entering an open face log. In this 
application, bag samples must be associated with profile holes. 

Observation Well. Check if observation well was installed in drill hole. 

Hammer_Method. Select Hammer Method from dropdown menu or insert nonstandard value 
with <ENTER> 

Rig Number. Select KYTC rig number from dropdown menu or insert value with <ENTER>. 

Refusal. It is only necessary to check this box for profile, sample, and sounding holes if it 
applies – core holes are checked automatically by the program. Likewise, only enter Refusal 
Depth and Lithology for non-core holes. 

Refusal Depth (ft). Depth, in feet, to refusal for profile, sample, and sounding holes. Refusal is 
defined in section GT-302-1 in the KYTC Geotechnical Manual. 

Refusal Lithology. The type of material refusal was reached on. 

Boulders. Check if boulders where encountered during drilling of hole. 

Driller Name. Pick name of driller from drop down menu. If driller name is not present add 
driller name under Data Design/Library Data under DRILLERS (Shown in Figure 2). 

 

 
Figure 2. Drillers Name List Location 

Driller Comments. This is a free form text field. Important: Any Information entered here about 
the hole will appear at the bottom of the driller’s log report. This field should include any 
information specific on if the hole was moved and reason for moving and any hole that is not 
drilled or deleted and the reason as specified in GT-303-1 in the KYTC Geotechnical Manual. 
Additionally, this field should include Profile Remarks for profile borings to describe points of 
interest (such as locations and magnitudes of sinkholes, ponds, creeks, wet areas, springs, wells, 
talus deposits, existing landslides, limits of wooded areas, crop intervals, etc.) with the point of 
interest station, feature description, and offset direction from centerline.  

Note: Specific driller comments associated with depth information in a specific borehole 
should not be included in this field, instead should be included in table Drillers Remarks 
under the Driller Forms tab. 

Slope Indicator. Check if inclinometer was installed. 
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Consecutive Samples. Check if continuous samples were obtained. 

Original Hole Location Information (Original Latitude, Original Longitude, Orig 
Elevation). (cannot be entered) If Hole Moved is check original values are saved in these fields. 

Hole Accuracy (Vertical Datum, Vertical Accuracy, Horizontal_Datum, Horizontal 
Accuracy). Values are populated when coordinate data submission form is import but should be 
changed if hole is moved and not resurveyed. 

GintPointSort. Can be used to sort holes since field Hole Number As Staked is numeric and 
may not go in order. 

Station Sort. Can be used to sort holes since stations may not be in order. 

Pay Estimate Table 

The pay estimate tab contains calculations that summarize drilling and sampling footages 
for preparation of cost estimates.  No data entry is necessary unless information about dozer 
time, grouting, or reclamation is required.  All tabs in the Driller Forms group must be 
completed before the Pay Estimate data is used.  To transfer these data to Excel for further 
calculations, select File > Import/Export > Export to Excel. 

 

 
Figure 3. Pay Estimate Table 

  



12 
 

Driller Forms 

 Important: When inputting information in the Driller’s Form tab make sure that the 
information being input is for the correct hole. The hole that is currently set for inputting is 
indicated at the top middle of the screen in a yellow dropdown menu, as shown in Figure 4. 

 

 

 

 
Figure 4. Hole Selection Dropdown 

Ground Water Table 

Enter one or more water level readings. For each date, enter the water depth in the hole 
(in feet) and whether it is an immediate or static reading. If more than one static reading is taken, 
the most recent is used on log reports. If the hole is dry, check the Dry field and leave the Water 
Depth blank. Holes with groundwater readings should have the Observation Well box checked 
in the Drill Hole table. 

 

 
Figure 5. Ground Water Table Example 

Core Runs Table 

Enter the Top Depth of each core run and assign it a Run Number. Runs must be 
consecutive footage intervals (i.e., no missing intervals). If gaps in coring occur, enter the 
interval footages and add a comment explaining the circumstances (e.g., mine void or cave).  
Bottom Depth will be calculated automatically when the record is saved. Enter the length of 

Current Hole 
Selected 
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recovered core from the run so that recovery percent can be calculated. There is a field for both 
the driller’s and geologist’s interpretation of this value. The driller’s will be imputing Driller 
Recovered Length (ft) and the Standard RQD Length (ft). The geologist will be entering in 
the Geologist Recovered Length (ft) and the KY RQD Length (ft). 

 
Figure 6. Core Runs Table Example 

Driller Soil Description Table 

 Enter the top depth of each soil unit. All intervals must have consecutive footage. Bottom 
Depths will be calculated in this order of precedence: 1) all lines except the last one are assigned 
the top depth of the next line, 2) if the hole involved coring, the bottom depth of the last line is 
set as the top depth of the first core run, 3) otherwise, the last depth is set as the bottom of the 
hole. Make sure to check this calculation and correct if necessary. Enter descriptive terms using 
the pull down menus for each field. Alternatively, enter a descriptive phrase in the Driller Soil 
Comments field. 

 

 
Figure 7. Driller Soil Description Table Example 

Driller Rock Description Table 

 For core holes, enter the Top Depth of each rock lithology layer. All intervals must be 
consecutive. Bottom Depths will be automatically calculated. Enter descriptive terms using the 
pull down menus for each field. Alternatively, enter a descriptive phrase in the Comment field. 
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Figure 8. Driller Rock Description Table Example 

Soil Samples Table 

 This table records sampled soil intervals in the hole. Because intervals are not 
consecutive, you must enter both the top and bottom depth of each interval. Enter the full depth 
penetrated for each sample interval even if all of the material was not recovered. Specify a 
unique sample number, the sampling method, and the thickness of recovered material. For SPT 
intervals, enter the number of blows for each six-inch increment. The Blowcounts field is 
calculated from values input and the format is specified in GT-302-5 in the KYTC Geotechnical 
Manual. (If entering blow counts for an old project, the final N Value can be entered manually in 
N-Value field). 

 

 
Figure 9. Soil Sample Table Example 

Profile Holes Table 

 Soil profile holes are the most complex kind of hole to enter, because of the way jar and 
bag samples can be taken.  To add a profile hole, enter the top depth of each soil horizon and its 
bag (soil) number.  If a bag sample was taken from the interval, check the “sampled” box and 
enter the bag number.  If an interval was not sampled, enter the bag number from a previous hole 
with the same soil type, but don’t check the “sampled” box. 
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Figure 10. Profile Holes Table Example 

Jar Samples Table 

Enter the depth and jar number for each jar sample taken in a profile hole. Profile 
intervals must already have been entered so that the program can determine which soil (and bag) 
interval each jar was taken from. There must be at least one jar for each bag taken. 

 

 
Figure 11. Jar Sample Table Example 

Driller’s Remarks 

 Enter in a remark that will display in the Remarks section on the right hand side of the 
Driller’s Subsurface Log. These comments need to include a depth value that the comment is 
relevant and will display at that depth. Include any information that involves samples, cores, or 
areas that loss of water was noted. 

 

 
Figure 12. Driller’s Remarks Table Example 
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Geology Forms 

 These table include all the data that geologist need to input to create geologist logs. It is 
best practice to work from left to right in the geology forms tables. Important: Two fields that 
needs to be entered by the geologist not in the geology forms is the Geologist Recovered 
Length and KY RQD Length located in the Drillers Forms, Core Runs table. 

Geologist Lithology Table 

 Enter the top depth of each rock lithology. Choose the primary lithology from the pull 
down menu (required), ad enter the complete description in the field provided. The comments 
field is for parenthetical comments that will be appended to the description paragraph. 

 

 
Figure 13. Geologist Lithology Table Example 

Core Hole Geology Table 

 This table records measurements and assessments made by the geologist for core holes.  
Select the correct hole number, then input the data that applies to the hole. This table will contain 
entries of Depth to Bedrock for sounding and sample holes. The depth to bedrock is copied 
from the Drill Hole table for sounding holes, therefore no entry is required. Additionally, 
samples that have core are pulled into the table during data entry of hole type, but Depth to 
Bedrock will need to be input for any sample hole that has core. Base Weathered Rock is the 
interpreted base of bearing rock and is only for structure projects. RDZ Depth is used for 
roadway projects and is defined in section GT-303-1 in the KYTC geotechnical manual as 
material deemed “rippable” with a D-9 dozer.   

Upper Geologic Unit represents the GQ formation or member at the surface where the 
hole is drilled. The Lower Geologic Unit is optional, and records the lowest unit encountered in 
the hole, if different from the upper unit.  Enter any depth measures that apply.  
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Figure 14. Core Hole Geology Table Example 

Hole Remarks Table 

 This area is for comments that need to be added to geologist logs reports. Enter the Top 
Depth and optionally the Bottom Depth that the remarks applies to. Do not enter the depths as 
part of the remark, they will be added from the database at report time.  

 

 
Figure 15. Hole Remarks Table Example 

ABC Table 

 One or more values for allowable bearing capacity (tons per square feet) can be entered 
by depth in the hole. The values are assumed to be applicable from depth specified downward 
until another allowable bearing capacity value is giving. 

 

 
Figure 16. ABC Table Example  
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Lab (Soils) Testing 

 These tables record information about soil samples taken and results of any laboratory 
tests. It is best practice to enter raw lab testing data, but final results can be entered as well. The 
soil specimen tab must be completed first, because values in these fields trigger the creation of 
necessary record in results tables. It is also best practice to procced from tabs left to right with 
data entry so that proper record can be generated in the more left tables. 

Soil Specimen Table 

 This is the most important table to setup correctly for lab testing. Upon saving of the 
table records can be created in the Sieve, Soil Classification, Proctor, CBR, QU, UU, CU, and 
KY Consolidation tables based on the information input for the sample. 

Top depth of soil samples, information about the sample and kinds of tests that are to be 
preformed are recorded in this table. Presuming an entry was added in Driller Forms/Soil 
Samples for the sample, a record should already exist for the depth with the Sample Type and 
Sample Number. There should also be jar samples added for jars entered in the Drillers Forms 
tab. Check the No Specimen box if there was insufficient material recovered. 

 Enter in Penetrometer for tests done on samples extracted from Shelby tubes and leave 
blank for other types of samples. The Number Specimens field refers to the number of samples 
that were created from a Shelby tube, not the number of tests conducted. Additionally, if a 
complete wax sample could not be created, select the pan option in the pull down menu. 

 For Specimen # Test fields input the type of test done for a single specimen. Include 
entry into one of the three Specimen # Test fields (going from left to right) for every sample that 
was tested from that specimen. For example, if three samples were made from a single Shelby 
tube and two Unconsolidated Undained Trixial (UU) test were conducted on two of the three 
samples it should be recorded as shown in Figure 16. When data is entered into the specimen test 
field appropriate sample information is created in the associated testing tables. 

 

 

 
Figure 17. Soil Specimen Table UU Example 

 If Consolidated Drained Triaxial (CU) test are conducted an associated Specimen 
Triaxial Set needs to be entered. The Specimen Triaxial Set is a letter that groups together all 
of the samples that were tested for that CU test set. CU test sets should start at A and procced 
alphabetically. For example, if three samples where tested for a CU test labeled A with two 

Three Samples 
Made 

Two Tests 
Conducted 
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samples coming from the same Shelby tube then data entry should like what is presented in 
Figure 17. 

 

 

 
Figure 18. Soil Specimen Table CU Example 

 Selected the type of sieve analysis conducted in the Sieve field dropdown menu. This 
selection is important since other lab tables are effected by the selection of type of sieve 
conducted. 

Natural Moisture Table 

 Raw weights in grams can be entered so that moisture percent values will be calculated.  
Note:  If one or more jar samples are taken for an interval in a profile hole, the program 
determines which bag number the jars apply to and adds a natural moisture record for the bag 
using the average moisture of jar samples.  There should be at least one moisture sample per bag. 

 

 
Figure 19. Natural Moisture Table Example 

Atterburg Table 

 Enter raw weights in the lower form for each Atterberg test performed. Can have as many 
Liquid and Plastic limits readings as desired. The program distinguishes between the two types 
by the blows/cone penetration fields. If these have values, then the reading is taken as a Liquid 
Limit reading, otherwise it is assumed to be a Plastic Limit reading. You can use the Casagrande 

Two Samples Tested That Are Part of 
CU Set A from the Same Shelby Tube 
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rotating cup method of Liquid Limit determination by filling in values for the blows field.  Use 
the cone penetrometer method by filling in those fields 

Casagrande Method Liquid Limit Calculations: 

============================================ 

If only one reading exists, the ASTM D4318 one point method is used. If two readings, two one-
point method calculations are averaged. If three or more, a best fit line through a graph of 
logarithm of blows vs. arithmetic water contents is used and the Liquid Limit is defined as the 
water content at 25 blows on this best fit line. 

 

Cone Penetrometer Liquid Limit Calculation: 

=========================================== 

You must have a minimum of three readings. A best fit line through a graph of arithmetic 
penetration vs. arithmetic water contents is used and the Liquid Limit is defined as the water 
content at 20mm on this best fit line. 

 

Plastic Limit Calculation: 

========================== 

Only one reading is required. The average of all the Plastic Limit readings is used as the final 
Plastic Limit value. 

 

 
Figure 20. Upper Atterberg Table Example 
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Figure 21. Lower (Raw Values) Atterburg Table Example 

Sieve Table 

 This table is used for raw sieve weight input. The information entered into the Soil 
Specimen table, Sieve field directly effects what is setup in this table when the Soil Specimen 
table is saved. The program supports splitting the test specimen. This is commonly done when 
the soil has a large gravel fraction. The specimen is split into coarse and fine fractions. The entire 
coarse fraction, and a portion of the fine fraction, are sieved. 

With unsplit specimens the weight passing the split sieve and the fine weight tested are 
not used and the fields relating to "Coarse" are used and the "Fine" fields are ignored.  If the 
specimen weight represented a wet condition, you must supply a "Coarse" water content.  
However, unsplit specimens are assumed to be sieved dry so the Coarse_Sieved_Wet field is 
ignored.  Finally, supply the weight of the Coarse sieving tare.  This can be 0. 

With split specimens the Wt Passing Split Sieve, the Wt Fines Tested, and the Split 
Sieve Size in mm must be supplied. If the soil was weighed wet, the water contents for coarse 
and fine fractions must be supplied. If the coarse fraction was sieved wet, check the Coarse 
Sieved Wet box. The fine fraction is assumed to be sieved dry. Finally, supply the weight of the 
Coarse and Fine sieving tares. They can be 0. 

 

 
Figure 22. Sieve Table Example (Left Side of Table) 
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Figure 23. Sieve Table Example (Right Side of Table) 

 

Table 1. Guideline for Entering Weights of Different Sieve Types 

 Wt. 
Total 
Spec. 

Wt 
Fines 

Tested 

Size 
Split 
Sieve 

WC 
Coarse 

Wet 

WC 

Coarse 

Dry 

WC 

Fine 

Wet 

WC 

Fine 

Dry 

Coarse 

Sieved 

Wet 

With Gravel actual actual 2 1 1 actual actual  

No Gravel 1 actual 2 1 1 actual actual  

Wash Grad actual - - 1 1 1 1 No 

 

 
Figure 24. Lower (Raw Data) Sieve Table Example 

SG (20c) Table 

 This table is only for entering raw specific gravity measurements on hydrometer samples.  
Results will be transferred to the Soil Classification table.  If raw data are not available, enter 
the SG values in Soil Classification directly. 
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Figure 25. SG (20c) Table 

Soil Classification Table 

This tab contains the results of all soil classification parameters and is also used to enter 
percent finer values for sieve analyses when no raw data are available. In the later case, enter the 
percent finer values in the lower form and the specific gravity in the upper form, and the soil 
classifications will be automatically calculated.  If these data are not available, the soil 
classification parameters can be entered in the upper form manually.  The Verified box will be 
checked for samples that have the Lock Sample box marked in the Soil Specimen tab to indicate 
that data can’t be modified. 

 
Figure 26. Soil Classification Table Example 

Proctor (Compaction) Table 

When entering raw data, pick the test method from the Method Tab, normally T99A for 
a standard KY proctor or T99C_KYM for a KY proctor sample containing over 5 percent rock.  
Enter the Mold Diameter, Height and Weight (roughly 4 in diameter, 4.584 in height, and 4236 
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grams for the weight). In the lower form enter your proctor analysis number for each point. The 
Mold Volume, Maximum Dry Unit Wt and Optimum Moisture Content are calculated. If not 
entering raw data just enter all numbers in the top form. The density units will be consistent with 
the Water Unit Wt field in the table PROJECT. For example, if Water_Unit_Wt = 62.4, the 
units will be in pounds per cubic foot, if 1, grams/cubic centimeter (or metric tons/cubic meter). 

 

 
Figure 27. Standard T99A Entry Example, Upper Table 

 

 

Figure 28. Standard T99A Example Raw Readings, Lower Table 

 

 

Figure 29. Modified Kentucky Proctor Entry Example, Upper Table 

 

 

Figure 30. Modified Kentucky Proctor Raw Readings, Lower Table 
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CBR (California Bearing Ratio) Table 

Enter the raw weights for the CBR test. 

 

 
Figure 31. CBR Table Example 

QU (Quick Undrained Triaxial) Table 

Enter the values specified in the QU table. Values needed Moisture (%), Dry Density 
(pcf), Maximum Stress (psf), Strain At Failure (%) and Limiting Stress @ 10% Strain (only 
if sample reached 10% strain). The Wet Density (pcf) will be calculated from the Dry Density 
and Moisture, or the Wet Density (pcf) can be entered and the Dry Density will be calculated. 
The Report File Name will be generated when the table is saved. When the file name is 
generated, save the lab report in a pdf file with the name assigned in the Report File Name field. 

 

 
Figure 32. QU Table Example 

 UU (Unconsolidated Undrained Triaxial) Table 

Enter the values specified for the UU table. Values needed are Maximum Stress (pcf), 
Strain (%) (which is strain at failure), Moisture (%), Dry Density (pcf), Limiting Stress @ 
10% Strain (only if sample reached 10% strain), and Cell Pressure (psi). The Report File 
Name will be generated when the table is saved. When the file name is generated, save the lab 
report in a pdf file with the name assigned in the Report File Name field. 

 

 
Figure 33. UU Table Example 
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CU (Consolidated Undrained Triaxial) Table 

 Enter the values specified for the CU table. Values needed are Triaxial Set, Phi (deg) 
(friction angle in degrees), and Cohesion (psf). Both values of Phi and Cohesion are effective 
strength parameters. The Report File Name will be generated when the table is saved. When the 
file name is generated, save the lab report in a pdf file with the name assigned in the Report File 
Name field. 

 

 
Figure 34. CU Table Example 

KY Consolidation Table 

 Enter the values specified for the consolidation test.  Values needed are the Saturated 
Moisture (%) (before the test at initial void ratio), Moisture (%) (natural moisture), Dry 
Density (pcf), PC (tsf) (preconsolidation pressure), CC (Compression Index), Cr (Recompression 
Index), and E0 (Initial/In Situ Void Ratio). Wet Density (pcf) will be calculated from the Dry 
Density and Moisture. The Report File Name will be generated when the table is saved. When 
the file name is generated, save the lab report in a pdf file with the name assigned in the Report 
File Name field. 

 

 
Figure 35. KY Consolidation Table Example 
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Rock Testing 

 This tab is for entering in lab testing conducted on rock samples. 

Rock QU Table 

 Enter the values specified for the sample. Values needed are Top Depth (ft) of the 
sample, Bottom Depth (ft), Sample Number, and the Strength Value (psf). The Report File 
Name will be generated when the table is saved. When the file name is generated, save the lab 
report in a pdf file with the name assigned in the Report File Name field. 

 

 
Figure 36. Rock QU Table Example 

Slake Durability Table 

 Each sample tested must have a depth. Enter the values specified for the SDI Result to be 
calculated, W1 (g) (weight before test) and W2 (g) (weight after test). The SDI Result will be 
calculated upon saving the table. 

 

 
Figure 37. Slake Durability Table Example 
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